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ET-dsPIC33WEB V1.0
 

 

 ET-dsPIC33WEB V1.0 เปนบอรดไมโครคอนโทรลเลอรในตระกูล dsPIC ของบริษัท Microchip โดยได

นําเอาไมโครคอนโทรลเลอรที่ประมวลผลขอมูลแบบ 16 บิต เบอร dsPIC33FJ128GP708 มาพัฒนาเปนบอรดใช

งาน ซึ่งคุณสมบัติเดนของ dsPIC33FJ128GP708 คือ หนวยประมวลผลสัญญาณดิจิตอล (Digital Signal 

Processing) และ ทรัพยากรตางๆ ดังตอไปนี้ 

 

หนวยประมวลผล  (CPU)  

• ความเร็วในการประมวลผล 40 MIPS (16 Bit Data / 24 Bit Instruction Code) 

• ฮารดแวรรองรับการคูณขอมูล 16 x 16 บิต โดยใชเวลาเพียง 1 ไซเคิลคําสั่ง  

• ฮารดแวรรองรับการหารขอมูล 32-bit x 16  บิต 

• C Compiler ถูกออกแบบใหมีความกระชับ Optimized Instruction Set 

• รองรับการ Interrupt มากถึง118  Vector Interrupt จาก 63 แหลง 7 Priority Level Program 

• รองรับการ DMA กับ Peripheral Hardware ได 8 ชอง พรอม DMA Buffer 2KByte 

ระบบ (System) 

• แหลงกําเนิดสัญญาณนาฬิกาสามารถเลือกได ทั้งจากภายในและภายนอก  

• มีวงจร Power-Up Timer และ Oscillator Start-Up 

• มีระบบตรวจสอบสัญญาณนาฬิกา (Fail-Safe Clock Monitor) 

•  ระบบ  Watchdog Timer ที่ใชแหลงสัญญาณนาฬิกาแบบ RC oscillator ที่แยกจากสวนอ่ืนๆ 

• ทํางานที่แรงดันระดับ 3.0 ถึง 3.6 โวลต  

• I/O Pin 4mA Sink สามารถเชื่อมตอกับสัญญาณ 5VTTL ได (5V Tolerant) 

• รองรับโหมดการทํางานแบบ  Run, Idle และ Sleep modes  

• สามารถปรับเปลี่ยนโหมดการทํางานของสัญญาณนาฬิกาไดหลากหลายเพื่อประสิทธิภาพ และ ให

สอดคลองกับการดูแลจัดการในเรื่องของพลังงาน 

คุณสมบัติทางดานสัญญาณอนาลอก (Analog Features) 

• โมดูลแปลงสัญญาณ Analog to Digital ความละเอียด 10-bit จํานวน 24 ชอง  และสามารถโปรแกรมเปน 

12Bit ได 2 ชอง ความเร็วในการ Sampling สัญญาณสูงสุด  1.1 MSPS   
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คุณสมบตัิโดยทั่วไปของ MCU เบอร dsPIC33FJ128GP708 

• หนวยความจําโปรแกรมแบบ Flash Memory ขนาด 128 K Byte 

• หนวยความจําขอมูล SRAM  ขนาด  16 K Byte 

• I/O Ports ใชงานจํานวน 69 บิต(รวม Peripheral Function ตางๆ) 

o โมดูลการสื่อสาร UART จํานวน 2 ชอง 

o โมดูลการสื่อสารแบบ SPI จํานวน 2 ชองรองรับทั้ง  Master และ  Slave Modes 

o โมดูลการสื่อสารแบบ  I2C จํานวน 2 ชองรองรับทั้ง  Master และ  Slave Modes 

o โมดูลการสื่อสารแบบ CAN จํานวน 2 ชอง 

o โมดูล Timer ขนาด  16-bit จํานวน 9 ชอง และสามารถจับคูใชงานเปน Timer ขนาด 32 Bit ได

พรอมกันจํานวน 4 ชอง 

o โมดูล Capture , Compare / PWM  จํานวน 8 ชุด 

o ระบบฮารดแวร  RTCC, Real-Time Clock Calendar with Alarms ภายใน 

o โมดูล ADC ขนาด 10Bit จํานวน 24 ชอง และสามารถโปรแกรมคาเปน 12Bit ได 2 ชอง 

o ระบบการสื่อสารแบบขนาน DCI(Data Converter Interface) จํานวน 1 ชอง 

คุณสมบตัิโดยทั่วไปของบอรด  ET-dsPIC33WEB V1.0 

- ใชไมโครคอนโทรเลอร dsPIC33FJ128GP708 ขนาด 80 PIN  

- สัญญาณนาฬิกาคริสตอลออสซิลเลเตอรขนาด  8 MHz  (สามารถใช  PLL รันไดถึง 40 MHz)   

- สัญญาณนาฬิกาคริสตอลออสซิลเลเตอรขนาด  32.768KHz สําหรับ RTC   

- I/O Port  ขนาด 10 PIN (จัดเรียงตามมาตรฐานของ อีทีที) จํานวน 9 พอรต 

- ชุดวงจร Line Driver RS232 จํานวน 2 พอรต 

- พอรตสําหรับตอ LCD เรียงตามมาตรฐานของ อีทีที (14Pin ET-CLCD) จํานวน 1 พอรต 

- ขั้วตอสัญญาณดาวนโหลดโปรแกรมแบบ ICD2 และ สวิตชตัดตอสัญญาณ Run / Program 

- วงจร LED สําหรับใชทดลองเอาตพุตแบบ Digital จํานวน 8 ชอง 

- วงจรสวิตช Push-Button สําหรับใชทดลองอินพุตแบบ Digital จํานวน 4 ชอง 

- วงจรสรางแรงดัน 0-3.3V จากตัวตานทานปรับคาได สําหรับทดลองโมดูล A/D จํานวน 1 ชอง 

- พอรตสําหรับเชื่อมตอกับโมดูล Ethernet รุน ET-MINI ENC28J60(ใช SPI1)  

- พอรตเชื่อมตอกับหนวยความจํา EEPROM 25LCxxx จํานวน 1 ชอง(ใช SPI2)  

- ชุด Regulate แบบ Switching สําหรับแปลงไฟ DC Input ใหเปน 5V และ 3.3 V 

- LED สถานะสําหรับ Power(แดง),Program(แดง) และ Run(เขียว) 

- ขั้วตอแรงดันไฟ VCC และ GND ใชไดกับไฟ 7-12 VDC 

 



คูมือการใชงาน ET-dsPIC33WEB V1.0 

3 

โครงสรางบอรด ET-dsPIC33WEB V1.0 

 

 
 

 

 

อธิบายรายละเอียดตามหมายเลขไดดังตอไปน้ี  

 

• หมายเลข  1  พอรตเชื่อมตอสัญญาณแบบ RS-232 จํานวน 2 พอรต มีวงจรการเชื่อมตอดังตอไปนี้ 
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1 2

3 4

5 6

7 8

9 10

RD0 RD1
RD2 RD3
RD4 RD5

+3.3V GND

PORTD-L

RD6 RD7

 

• หมายเลข  2    พอรต ET-CLCD สําหรับเชื่อมตอกับจอแสดงผล LCD แบบตัวอักษร (Character LCD) 

โดยมีการจัดวางขาสัญญาณตางๆ ดังตอไปนี้ 

 

 
 

• หมายเลข  3 , 4 , 5 , 6 , 7, 8 , 9, 10  และ 11    คือ พอรต I/O ของไมโครคอนโทรเลอร ที่ถูกออกแบบ

ใหอยูในรูปแบบของพอรตมาตรฐาน 10-PIN ETT โดยในแตละพอรตมีการจัดเรียงสัญญาณดังตอไปนี้ 
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RG0 RG1
RG2 RG3
RG6 RG7

+3.3V GND

PORTG-L

NC NC

 

1 2

3 4

5 6

7 8

9 10

RG8 RG9
RG12 RG13
RG14 RG15

+3.3V GND

PORTG-H

NC NC

 

1

2

RF8

RF8

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 12  พอรตสัญญาณ I/O ขนาด 2 PIN คือ สัญญาณ RF8 และ GND ดังตอไปนี้ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* NC = No Connect 
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• หมายเลข 13  ขั้วตอสําหรับดาวนโหลดโปรแกรม เปนขั้วที่จัดเรียงตามมาตรฐานของ ICD2 รองรับเครื่อง

โปรแกรมที่มีการเชื่อมตอตามมาตรฐานของ ICD2  เชน  PICKit2 , ICD2 และ เครื่องโปรแกรมของทาง

บริษัท อีทีที คือ ET-PGMPIC USB โดยกอนทําการโปรแกรมทุกครั้งตองกดสวิตช MODE ใหมาอยูที่

ตําแหนง PGM ทุกครั้ง เพื่อตัดตอขาสัญญาณมาเขากับเครื่องโปรแกรมจากภายนอก 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 14  สวิตชเลือกโหมด RUN และ PGM สวิตชนี้ เมื่อกดมาที่ตําแหนง PGM จะทําหนาที่ตัดตอ

ขาสัญญาณที่ใชในการโปรแกรมโคดขอมูลเขากับเครื่องโปรแกรม เพื่อทําการโปรแกรมขอมูลโปรแกรมที่

เราออกแบบ  และ เมื่อกดปลอยกลับมาที่ตําแหนง RUN ขาสัญญาณตางๆ จะกลับมาเปน I/O ใชงานได

ตามปรกติ 
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1 2

3 4

5 6

7 8

9 10

RG6 (SCK) RG7(SO)
RG8 (SI) RD12 (CS)

NC NC

+3.3V GND

SPI MEMORY

NC NC

 

จัมเปอรสําหรับการเลือกการเชื่อมตอสัญญาณ RA12, RD15 และ RA13 

ของไมโครคอนโทรลเลอร กับขาสัญญาณ INT, RST และ WOL ของโมดูล 

ET-MINI ENC28J60  

   DIS = Disable คือ ไมเชื่อมตอสัญญาณ 

   EN  = Enable  คือ เชื่อมตอสัญญาณ

• หมายเลข  15  ขั้วตอ DC-JACK สัญญาณไฟเลี้ยงบอรด รองรับแรงดันไฟจากภายนอก 7-12 VDC 

• หมายเลข  16  สวิตชรีเซต (Reset Switch) 

• หมายเลข  17  ไอซีไมโครคอนโทรเลอร dsPIC33FJ128GP708   

• หมายเลข  18   หนวยความจํา EEPROM เบอร 25LCxxx ของ บริษัท Microchip เชือ่มตอแบบ SPI   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 19  ขั้วสัญญาณเชื่อมตอกับโมดูลสื่อสาร Ethernet รุน ET-MINI ENC28J60 
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2-Pin CON
10K

SW-Button

+3.3V

 

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

 

• หมายเลข 20   ชุด Test I/O LED ประกอบดวยหลอดไฟ LED จํานวน 8 ชุด ดังวงจรตอไปนี้ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 21  ชุดทดลองสัญญาณอินพุท จากสวิตช 4 ชุด สามารถสรางสัญญาณลอจิก 0 (0 โวลท) และ 

ลอจิก    1  ( +3.3 โวลท)  ดังวงจรตอไปนี้ 

 

 

 

 

 

 

 

 

 

• หมายเลข 22  ชุดทดลองแรงดันอนาลอก 4 ชุด สามารถปรับระดับแรงดันไฟไดตองแต 0 – 3.3 โวลท โดย

มีการตอวงจรดังตอไปนี้  

 

 

 

 

 

 

• หมายเลข 23   พื้นที่อเนกประสงค สําหรับตอวงจรเพิ่มเติม  
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โมดูล ET-MINI ENC28J60   

ET-MINI ENC28J60  เปนโมดูลที่ออกแบบมาเพื่อเปนตัวกลางในการเชื่อมตอระบบการสื่อสารระหวาง

ไมโครคอนโทรลเลอร กับโครงขาย Ethernet รองรับการทํางานของโปรโตคอล TCP/IP  โดยใชไอซี ENC28J60 ซึ่ง

เปนไอซี Ethernet Controller รองรับมาตรฐานการสื่อสาร IEEE 802.3 เชื่อมตอสัญญาณควบคุมผาน SPI Bus 

ความเร็วสูงสุด 10 Mb/s ในการพัฒนาโปรแกรมทางบริษัท Microchip จะสนับสนุนตัว Microchip TCP/IP Stack  

ซึ่งสามารถดาวนโหลด และ นําไปใชไดฟรีที่เว็ปไซตของ Microchip (www.microchip.com)  โดยคุณสมบัติคราวๆ 

ของ ENC28J60 จะเปนดังนี้ 

 

คุณสมบัติของ IC ENC28J60  

General: 

• IEEE 802.3 compatible Ethernet Controller 

• Integrated MAC and 10BASE-T PHY 

• 8 Kbyte Transmit/Receive Packet Dual Port Buffer SRAM 

• Programmable Automatic Retransmit on Collision 

• Programmable Padding and CRC Generation 

• Programmable Automatic Rejection of Erroneous Packets 

• SPI™ Interface with speeds up to 10 Mb/s 

• Supports Full and Half-Duplex modes 

 

Buffer: 

• Configurable transmit/receive buffer size 

• Hardware managed circular receive FIFO 

• Byte-wide random and sequential access 

• Internal DMA for fast memory copying 

• Hardware assisted IP checksum calculation 

 

PHY: 

• Wave shaping output filter 

• Loopback mode 
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MAC: 

• Support for Unicast, Multicast and Broadcast packets 

• Programmable pattern matching of up to 64 bytes within packet at user defined offset 

• Programmable wake-up on multiple packet formats,including Magic Packet®, Unicast, 

Multicast, Broadcast,specific packet match or any packet 

 

 การเชื่อมตอกับไมโครคอนโทรลเลอร สามารถทําไดโดยงาย โดยจะใชการเชื่อมตอแบบ SPI Bus ซึ่งจะใช

ขาสัญญาณเพียงไมก่ีขา และ ในสวนของระบบไฟ เนื่องจาก ENC28J60 เปนไอซีที่ทํางานที่แรงดัน 3 โวลท ดังนั้น

เพื่อใหสามารถใชงานไดกับไมโครคอนโทรลเลอรที่ทํางาน 5 โวลท ทางทีมงานจึงไดออกแบบ วงจรบัฟเฟอร สําหรับ

รองรับการเชื่อมตอระบบไฟ ระหวาง 3 โวลท กับ 5 โวลท เอาไวภายในบอรด ET-MINI ENC28J60  ซึ่งสามารถ

เลือกระบบไฟไดโดยการเลือก จัมพเปอร  5V/3V3   

 
 

 
รูปแสดงบล็อกไดอะแกรมการเชื่อมตอ ENC28J60 กับ ไมโครคอนโทรลเลอร 
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+5V

+3.3V

VDD

 
 

รูปแสดงโครงสรางของบอรด ET-MINI ENC28J60  

 

 จากรูป HD1 และ HD2 ออกแบบไวสําหรับการเชื่อมตอกับบอรด ET-dsPIC33WEB V1.0 โดยสามารถ

เสียบบอรด ET-MINI ENC28J60 ซอนทับบนบอรด ET-dsPIC33WEB V1.0 เขากับขั้ว Connector ตัวเมียที่

จัดเตรียมไวใหไดทันที สวน HD3 ออกแบบไวสําหรับนําไปใชเชื่อมตอกับไมโครคอนโทรเลอรอ่ืนๆตามตองการ 

 

 

คําเตือน : จะตองเลือกจัมเปอรให
ถูกตองตามการใชงานจริงไมเชนนั้น
อาจเกิดความเสียหายแกอุปกรณได
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ชื่อสัญญาณ ชนิดของสัญญาณ หนาท่ีการทํางาน 

CS INPUT สัญญาณ Enable/Disable การเชื่อมตอ SPI Bus ของ ENC28J60 

     CS = 0  คือ Enable การเชื่อมตอ SPI ของ ENC28J60 

     CS = 1  คือ Disable การเชื่อมตอ SPI ของ ENC28J60 

SDO OUTPUT สัญญาณ Serial Data Output  

SCK INPUT สัญญาณนาฬิกา  Serial Clock 

SDI INPUT สัญญาณ Serial Data Input 

INT OUTPUT สัญญาณอินเตอรรัพท แอคทีฟ ลอจิก 0 

RST INPUT สัญญาณรีเซต แอคทีฟ ลอจิก 0 

WOL OUTPUT สัญญาณ Wake-up on LAN interrupt  แอคทีฟ ลอจิก 0 

CLKO OUTPUT สัญญาณ Programmable clock output 

LEDA OUTPUT แสดงสถานะของสัญญาณ  LINK 

LEDB OUTPUT แสดงสถานะของสัญญาณ   ACT 

 

ตาราง แสดงชื่อและหนาท่ีขาสัญญาณตางๆ ของ  ENC28J60 

 

 

 

ENC28J60 ET-dsPIC33WEB V1.0 

(dsPIC33FJ128GP708) 

CS RD14 

SDO RF8 

SCK RF6 

SDI RF7 

INT RA12 (เลือกใชโดยจัมเปอร) 

RST RD15 (เลือกใชโดยจัมเปอร) 

WOL RA13 (เลือกใชโดยจัมเปอร) 

CLKO - 

LEDA - 

LEDB - 

 

ตารางแสดง สัญญาณการเชื่อมตอระหวางบอรด ENC28J60 กับ ET-dsPIC33WEB V1.0 
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สรุปการจัดสรรและใชงานทรัพยากรของบอรด ET-dsPIC33WEB V1.0 
 

 ตามปรกติแลว MCU เบอร dsPIC33FJ128GP708 ที่ใชกับบอรด ET-dsPIC33WEB V1.0 นั้น จะมี

ขาสัญญาณใหใชงานไดโดยอิสระมากถึง 69 I/O แตจะมีขาสัญญาณบางสวน ถูกออกแบบและเชื่อมตอไวกับ

อุปกรณ I/O เปนการเฉพาะไวเรียบรอยแลว ไมสามารถนํามาใชเปน I/O โดยทั่วไปได ซึ่งพอสรุปไดดังนี้ 

 

MCU Oscillator 

• RC12 ใชเปน OSC1 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 

• RC15 ใชเปน OSC2 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 
 

RTC Oscillator 

• RC13 ใชเปน OSC1 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 

• RC14 ใชเปน OSC2 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 
 

พอรตส่ือสารอนุกรม(UART) RS232-CH1 

• RF2 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-1 

• RF3 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-1 
 

พอรตส่ือสารอนุกรม(UART) RS232-CH2 

• RF4 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-2 

• RF5 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-2 
 

Ethernet Module (SPI-1) 

• RF6 ใชเปน SCK ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF7 ใชเปน SDI ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF8 ใชเปน SDO ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RD14 ใชเปน CS ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RA12 ใชเปน INT1 ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) โดยสามารถเลือกใช

หรือไมใชได โดยการกําหนดที่ Jumper INT(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RA13 ใชเปน WOL ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใช

หรือไมใชได โดยการกําหนดที่ Jumper WOL(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RD15 ใชเปน RST ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใช

หรือไมใชได โดยการกําหนดที่ Jumper RST(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 
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SPI Memory Module (SPI-2) 

• RG6 ใชเปน SCK ในการเชื่อมตอกับ SPI Memory 

• RG7 ใชเปน SDI ในการเชื่อมตอกับ SPI Memory 

• RG8 ใชเปน SDO ในการเชื่อมตอกับ SPI Memory 

• RD12 ใชเปน CS ในการเชื่อมตอกับ SPI Memory 

 

Character LCD Display 

• RD0 ใชเปน LCD D4 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD1 ใชเปน LCD D5 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD2 ใชเปน LCD D6 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD3 ใชเปน LCD D7 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD4 ใชเปน LCD RS ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD5 ใชเปน LCD RW ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RD6 ใชเปน LCD EN ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 
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การพัฒนาโปรแกรมของบอรด 

 สําหรับการพัฒนาโปรแกรมของบอรด “ET-dsPIC33WEB V1.0” นั้น จะแบงออกเปน 2 สวน

ดวยกัน คือ สวนของการพัฒนาโปรแกรม และการ Download โปรแกรม โดยในสวนของการพัฒนา

โปรแกรมของบอรดนั้น จะเปนการเขียนโปรแกรมเพื่อควบคุมและสั่งงานให MCU สามารถทํางานตาม

จุดประสงคที่ไดออกแบบไว ซึ่งในสวนนี้เปนหนาที่ของผูพัฒนาโปรแกรม วาจะเลือกใชภาษาใดในการ

พัฒนาโปรแกรม รวมไปถึงการเลือกใชโปรแกรมสําหรับทําหนาที่แปลคําสั่งของภาษานั้นๆ ใหเปนรหัสคําสั่ง

ในรูปแบบของ HEX File สําหรับใช Download ใหกับหนวยความจําโปรแกรม (Flash Memory) ของ MCU 

เพื่อสั่งงานให MCU ปฏิบัติตามคําสั่งในโปรแกรมที่ผูพัฒนาโปรแกรมเขียนขึ้นมา 

 สําหรับสวนของการ Download โปรแกรม หรือการ Download HEX File ที่ไดจากการพัฒนา

โปรแกรมใหกับหนวยความจําโปรแกรม (Flash Memory) ของ MCU นั้น จะตองอาศัยเครื่องมือทาง

ฮารดแวรเปนสวนประกอบในการพัฒนาโปรแกรมดวย ซึ่งในกรณีของบอรด “ET-dsPIC33WEV V1.0” นั้น 

จะตองใช เครื่องมือสําหรับโปรแกรมขอมูลใหกับ MCU ภายในบอรดดวยวิธีการแบบ In-Circuit โดยตองใช

เครื่อง Programmer หรือใชชุดพัฒนาโปรแกรมจําพวก In-Circuit Debugger ที่สนับสนุนการใชงาน

รวมกับ MCU เบอร dsPIC33FJ128GP708 ซึ่งใชขั้วตอสัญญาณตรงตามมาตรฐาน “ICD2” ของ 

Microchips เชน ICD2,Pickit2 ซึ่งทางบริษัท อีทีที ก็มีสนับสนุน คือ “ET-PGMPIC USB” ดังตัวอยาง 
 

 
 

ET-dsPIC33WEB V1

ET-PGMPIC USB
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การเขียนโปรแกรมใชงานกับบอรดโดยใช MPLAB C30 
 MPLAB C30 หรือ C30 Tools เปนโปรแกรมภาษาซี สําหรับใชแปลคําสั่งของ MCU ตระกูล dsPIC 

ซึ่งไดรับการพัฒนาขึ้นโดย Microchips เอง โดยขอกําหนดและรายละเอียดของการเขียนโปรแกรมภาษาซี

นั้น จะไมกลาวถึงในที่นี้ดวย โดยถาผูใชตองการพัฒนาโปรแกรมใหกับ dsPIC ดวยภาษาซี แตยังไมมี

ความรูเรื่องการเขียนโปรแกรมภาษาซีเลยนั้นขอแนะนําให หาหนังสือที่อธิบายเกี่ยวกับการเขียนโปรแกรม

ภาษาซีในสวนที่เปนมาตรฐานตามขอกําหนดของ “ANSI C” มาศึกษาใหเขาใจเสียกอน และสําหรับสวน

ของขอกําหนดปลีกยอยอ่ืนๆที่เปนของ MPLAB C30 เองก็สามารถอานเพิ่มเติมไดจากเอกสารและคูมือการ

ใชงานของ MPLAB C30 ที่ทาง Microchips จัดทําไวได โดยสามารถ Download จาก Website ของ 

Microchips หรือจาก Folder ของ “C:\Program Files\Microchip\MPLAB C30\docs” ที่ทําการติดต้ัง

โปรแกรม MPLAB C30 ไวก็ได โดยในที่นี้ จะขอกลาวแนะนําถึงเฉพาะสวนของการกําหนดคาตัวเลือกใน

โปรแกรมเพื่อใชงานรวมกับบอรด “ET-dsPIC33WEB V1.0” เทานั้น โดยในการที่จะใชงานโปรแกรม 

MPLAB C30 ในการเขียนโปรแกรมนั้น ผูใชจําเปนตองทําการติดต้ังโปรแกรมของ Microchips จํานวน 2 

โปรแกรมดังนี้คือ 
 

 MPLAB IDE ซึ่งเปนโปรแกรม Text Editor ของ Microchips ซึ่งในปจจุบัน (ตุลาคม 2548) 

จะเปนรุน 7.21 แลวสามารถ Download มาใชงานไดฟรีจาก Web ของ Microchips 

 MPLAB C30 ซึ่งเปนตัวแปลภาษาซี (C Complier) ใหเปนรหัสคําสั่งของ dsPIC ซึ่งตาม

ปรกติแลวโปรแกรมชุดนี้จะตองซื้อมาใชงานเอง แตอยางไรก็ตามทาง Microchips เองมี

รุนทดลองใชงานใหผูใชสามารถ Download มาใชงานไดเชนเดียวกันกับ MPLAB IDE 
 

โดยโปรแกรมทั้ง 2 ชุดนี้ ทางอีทีที ไดทําการ Download มาจัดเตรียมไวใหในแผน CD-ROM ที่แถม

ไปกับบอรดของ “ET-dsPIC33WEB V1.0” ดวยอยูแลว โดยในการติดต้ังโปรแกรมนั้นขอแนะนําใหผูใชทํา

การติดต้ังโปรแกรมในชุดของ MPLAB IDE กอนเปนอันดับแรก โดยขอแนะนําใหติดต้ังโปรแกรมของ 

MPLAB IDE ไวตามคา Default ของโปรแกรมติดต้ังเลย คือ “C:\Program Files\Microchip\MPLAB IDE\" 

จะสะดวกตอการใชงานมากกวา ซึ่งหลังจากทําการติดต้ังโปรแกรม MPLAB IDE เสร็จเรียบรอยแลวในครั้ง

แรกกอนการใชงานนั้นตองสั่ง Restart เครื่องคอมพิวเตอรกอน หลังจากนั้นแลว MPLAB IDE จึงจะ

สามารถทํางานไดโดยไมเกิดปญหา จากนั้นจึงทําการติดต้ังโปรแกรม MPLAB C30 เปนลําดับถัดไป โดยขอ

แนะนําใหทําการติดต้ังโปรแกรมชุดนี้ไวตามคา Default ของการติดต้ังโปรแกรม จะเกิดความสะดวกตอการ

ใชงานมากที่สุด โดยเฉพาะในขั้นตอนของการกําหนดการเชื่อมโยงการทํางานระหวาง MPLAB IDE และ 

MPLAB C30 โดยในที่นี้จะขออธิบายโดยอางถึงตําแหนงการติดต้ังโปรแกรมดังที่กลาวไวแลวขางตนเทานั้น 

ซึ่งถาผูใชทําการสั่งติดต้ังโปรแกรมไวยังตําแหนง Folder ที่แตกตางไปจากนี้แลวขอใหทําความเขาใจและ

ดัดแปลงวิธีการกําหนดคาเองตามที่ติดต้ังโปรแกรมไวจริงๆดวย 
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ตัวอยางการสรางโปรแกรมภาษาซีของ MPLAB C30 

เมื่อทําการติดต้ังโปรแกรมกําหนดการเชื่อมโยงคําสั่งระหวาง MPLAB IDE และ MPLAB C30 เปน

ที่เรียบรอยแลว ตอจากนี้ไป ผูใชก็สามารถทําการเรียกใชงานโปรแกรม MPLAB C30 ผานทางโปรแกรม 

MPLAB IDE ไดแลว โดยคาตัวเลือกตางๆที่ไดกําหนดไวแลวนั้นจะถูกเก็บไวใน Configuration ของ

โปรแกรมตลอดไป จนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งในที่นี้จะขอยกตัวอยางการเขียนโปรแกรม

ภาษาซี ของ MPLAB C30 สัก 1 ตัวอยางพอเปนแนวทางใหผูใชทําความเขาใจ โดยมีลําดับขั้นตอนดังนี้ 

1. สั่ง Run Program ของ MPLAB IDE ขึ้นมา จากน้ันก็สั่งสรางไฟลใหมขึ้นมา 1 ไฟล สําหรับเขียน 

Source Code ภาษาซี โดยใชคําสั่ง “File → New” จากนั้นใหทําการพิมพ Source Code ภาษาซี

ใน Work Sheet ของโปรแกรม MPLAB IDE ดังตัวอยาง 

 

 
 

 

2. ทําการสั่งบันทึกไฟลที่เขียนขึ้นใหเปน Text File ภาษาซี โดยใหทดลองกําหนดชื่อเปน “main.c” 

แลวสั่งบันทึกไวใน Folder ชื่อ “…\Microchip\MPLAB C30\examples\led_blink\main.c” โดยใน

ที่นี้ใหใชคําสั่ง “File → Save As…” แลวสราง Folder ชื่อ led_blink ไวภายใต Folder ของ 

examples อีกชั้นหนึ่ง แลว กําหนดชื่อเปน “main.c” แลวเลือก “Save” ดังรูป 
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 ซึ่งจะเห็นวาเมื่อทําการสั่งบันทึกไฟลเปน “main.c” ไปแลว กลุมของตัวอักษรตางๆที่ไดพิมพไว จะ

ถูกจัดแบงกลุม โดยใชสีในการแสดงผลที่แตกตางกันไปตามหนาที่ของกลุมตัวอักษร เชน กลุมตัวอักษรที่ใช

เปนคําอธิบาย (Comment) กลุมตัวอักษรที่เปนคําสั่ง และกลุมตัวอักษรที่เปนตัวแปรตางๆ ซึ่งจุดนี้เปนขอดี

ของ MPLAB IDE ที่สามารถแยกการแสดงผลกลุมตัวอักษรตามหนาที่การใชงานได ทําใหเราสามารถอาน

โปรแกรมไดงายและสะดวกมากยิ่งขึ้นดังรูป 
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#include "p33FJ128GP708.h"     // dsPIC33FJ128GP708 MPU Register 
 
/* Setup Configuration For ET-dsPIC33WEB-V1 */ 
_FOSCSEL(FNOSC_PRIPLL &    // Select Primary OSC = XT + PLL 
         IESO_OFF )    // Startup With User Select OSC 
_FOSC(FCKSM_CSDCMD &           // Clock Switch Disabled  
      OSCIOFNC_OFF &    // OSC2 Pin = Clock O/P 
      POSCMD_XT)     // Primary OSC = XT  
_FWDT(FWDTEN_OFF &              // Disable Watchdog Timer  
      WINDIS_OFF &             // Disabled Windowed WDT 
      WDTPRE_PR128 &           // Watchdog prescaler=1:128 
      WDTPOST_PS32768)        // Watchdog postscaler=1:32,768 
_FPOR(FPWRT_PWR128)          // Power-on Reset Value = 128ms 
_CONFIG3(JTAGEN_OFF);    // Disable JTAG Interface 
/* End of Configuration For ET-dsPIC33WEB-V1 */ 
 
/* Pototype Section */ 
void delay(unsigned long int);  // Delay Time Function 
 
int main(void) 
{   
  /* Start of PLL Config Fcy = 40MIPS */ 
  CLKDIV &= 0xFFE0;    // PLLPRE[4..0] = 00000 (N1=2) 
  CLKDIV &= 0xFF3F;    // PLLPOST[1:0] = 00 (N2=2) 
  PLLFBD  = 0x26;     // PLLDIV[8..0] = 000100110(M=40) 
  while(!OSCCONbits.LOCK);   // Wait PLL to Lock 
  OSCCONbits.CLKLOCK = 1;   // Disable PLL Modify 
  /* End of PLL Config Fly = 40MIPS */ 
  
  /* Start Config RB8 = Output */ 
  AD1PCFGLbits.PCFG8 = 1;   // AN8(RB8) = Digital Mode 
  TRISBbits.TRISB8 = 0;    // RB8 = Output 
  LATBbits.LATB8 = 0;    // Start = ON LED 
 
  while(1)      // Loop Continue 
  { 
    LATBbits.LATB8 = !LATBbits.LATB8;  // Toggle Output RB8  
    delay(2000000);       // Display LED Delay   
  }    
}    
 
/***********************/ 
/* Delay Time Function */ 
/*    1-4294967296     */ 
/***********************/ 
void delay(unsigned long int count1) 
{ 
  while(count1 > 0) {count1--;}  // Loop Decrease Counter  
} 
 

 

แสดง ตัวอยาง Source Code สําหรับใชทดลองการทํางาน 
 

 สําหรับตัวอยางนี้จะเปนการสั่งใหใชพอรต RB8 ทําหนาที่เปน Output ขับ LED ใหติดและดับ

สลับกันไปไมรูจบในลักษณะของไฟกระพริบ ซึ่งวิธีการทดสอบการทํางานของโปรแกรมนี้ โดยใชกับบอรด 
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ET-dsPIC33WEB V1.0 นั้นทําไดโดยตอสัญญาณจาก RB8(PORTB-H) เขากับ LED1 Output ของบอรด 

โดยจะเห็นผลการทํางานของโปรแกรมแกรม คือ LED1 จะกระพริบ ติดและดับอยางตอเนื่องตลอดเวลา 

 โดยสวนที่สําคัญและมีความจําเปนมากที่สุดของโปรแกรมก็คือสวนของคําสั่งที่ใชในการกําหนดคา

ของ Configuration Bit ใหกับ MCU โดยคานี้จะถูกแปลและใชกําหนดคาการทํางานของ Fuse Bit ในตัว 

MCU ในขั้นตอนของการ Download Code ใหกับ MCU โดยในตัวอยางเปนการกําหนดให MCU ทํางาน

ดวยสัญญาณนาฬิกา 8MHz จากภายนอก รวมกับวงจรคูณความถี่ (Phase Lock Loop :PLL) ซึ่งตัวอยาง

โปรแกรมตางๆที่ทางอีทีที สรางขึ้น จะอางอิงจาก Configuration ดังตอไปนี้ 

• กําหนดให MCU ทํางานจากสัญญาณนาฬิกา : XTAL = 8MHz (XT+PLL)  

• กําหนดคาการทํางานของวงจรคูณความถี่ Phase Lock Loop ดังนี้ 

o PLLPRE[4..0] = 00000 (N1=2)      

o VCO Input = 8MHz / 2 = 4MHz      

o PLLDIV[8..0] = 0x26(M=40)        

o VCO Output = 4 x 40MHz = 160MHz  

o PLLPOST[1:0] = 0:0 (N2=2)        

o Fosc = 160MHz / 2 = 80MHz        

o Fcy = Fosc/2 = 80MHz /2 = 40MHz 
 

/* Setup Configuration For ET-dsPIC33WEB-V1 */ 
_FOSCSEL(FNOSC_PRIPLL &    // Select Primary OSC = XT + PLL 
         IESO_OFF )    // Startup With User Select OSC 
_FOSC(FCKSM_CSDCMD &           // Clock Switch Disabled  
      OSCIOFNC_OFF &    // OSC2 Pin = Clock O/P 
      POSCMD_XT)     // Primary OSC = XT  
_FWDT(FWDTEN_OFF &              // Disable Watchdog Timer  
      WINDIS_OFF &             // Disabled Windowed WDT 
      WDTPRE_PR128 &           // Watchdog prescaler=1:128 
      WDTPOST_PS32768)        // Watchdog postscaler=1:32,768 
_FPOR(FPWRT_PWR128)          // Power-on Reset Value = 128ms 
_CONFIG3(JTAGEN_OFF);    // Disable JTAG Interface 
/* End of Configuration For ET-dsPIC33WEB-V1 */ 
 

 สวนของคําสั่งในการกําหนดคาการทํางานของ Phase Lock Loop เพื่อทําการคูณความถี่จาก

สัญญาณนาฬิกา 8.00MHz ที่ตอไวภายนอก เพื่อใหไดความถี่ Fosc เปน 80 MHz เพื่อให CPU สามารถ

ประมวลผลดวยความเร็วสูงสุดที่ 40MIPS (Fcy = 40MHz) ดังตัวอยาง 
 

/* Start of PLL Config Fcy = 40MIPS */ 
  CLKDIV &= 0xFFE0;    // PLLPRE[4..0] = 00000 (N1=2) 
  CLKDIV &= 0xFF3F;    // PLLPOST[1:0] = 00 (N2=2) 
  PLLFBD  = 0x26;     // PLLDIV[8..0] = 000100110(M=40) 
  while(!OSCCONbits.LOCK);   // Wait PLL to Lock 
  OSCCONbits.CLKLOCK = 1;   // Disable PLL Modify 
  /* End of PLL Config Fly = 40MIPS */ 
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3. ทําการสราง Project File เพื่อใชสั่งผนวกไฟลตางๆ ที่เกี่ยวของเขาดวยกัน ทั้งนี้เนื่องมาจากวา

ภาษาซีของ MPLAB C30 นั้น ถูกออกแบบใหมีความออนตัวในการใชงาน ดังนั้นจึงมีการจัดสราง

และแบงแยกไฟลออกเปนหลายๆไฟลตามหนาที่การใชงาน เพื่อใหผูใชสามารถเรียกไฟลตางๆ

เหลานั้นเขามาใชงานรวมกับ Source Code  ที่เขียนขึ้นมาไดไดงาย โดยไมตองเสียเวลาเขียน 

Source Code เองทั้งหมด ซึ่งจะทําใหผูใชสามารถลดเวลาในการเขียนโปรแกรมไปไดเปนอยาง

มากเนื่องจากเพียงแตทําการสั่งผนวกไฟลที่ทาง MPLAB C30 สรางเตรียมไวให เขากับ Source 

Code ที่ผูใชเขียนขึ้นใหมแลวสั่งแปลโปรแกรมก็จะไดไฟลที่มีความสมบูรณตอการใชงานแลว โดย

จากตัวอยาง Source Code ที่ไดทดลองเขียนไปแลวในขางตน ก็เชนเดียวกัน จะเห็นไดวามีการสั่ง

ผนวกไฟลชื่อ “p33FJ128GP708.h” เขามาใชงานดวย ซึ่งทําใหไมตองเสียเวลาไปสั่งประกาศชื่อ

และตําแหนงรีจิสเตอรตางๆของ “dsPIC33FJ128GP708” ใหเสียเวลา แตสามารถอางถึงชื่อของ

รีจิสเตอรตางๆในโปรแกรมไดทันที โดยวิธีการกําหนดคุณสมบัติของ Project File มีดังนี้ 

 สั่งกําหนดคุณสมบัติของ project File โดยใชคําสั่ง “Project → Project Wizard…” ซึ่ง

จะไดผลดังรูป จากนั้นใหเลือก “Next >” เพื่อไปยังขั้นตอนตอไป 

 

  
 

 หลังจากเลือก “Next >” แลว โปรแกรมจะรอใหกําหนดเบอรของ MCU ที่จะใชงานรวมกับ

โปรแกรมที่เขียนขึ้น ซึ่งใหเลือกกําหนดเปน “dsPIC33FJ128GP708” จากนั้นเลือก “Next >” เพื่อขามไป

ทํางานยังขั้นตอนตอไปดังรูป 
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 ในขั้นตอนนี้จะเปนการเลือกวาจะใชโปรแกรมชุดใดในการแปลคําสั่ง เนื่องจาก MPLAB IDE 

สามารถใชงานไดกับชุดโปรแกรมตางๆมากมายหลายโปรแกรม ซึ่งในที่นี้ใหเลือกกําหนดใชโปรแกรม ของ 

MPLAB C30 โดยการเลือกกําหนดตัวเลือกของ “Active Toolsuite” ใหเปนของ MPLAB C30 โดยกําหนด

ตัวเลือกเปน “Microchip C30 Toolsuite”  ดังรูป แลวเลือก “Next >” 
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ในขั้นตอนนี้จะเปนการ กําหนดชื่อ Project และตําแหนง Folder ที่จะใชเก็บไฟลตางๆที่ไดจากการ

ทํางานของ Project โดยใหกําหนดชื่อเปน “LED_BLINK” ดังรูป แลวเลือก “Next >” 
 

 
 

↓ 
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 ในขั้นตอนนี้จะเปนการสั่งผนวกไฟลตางๆเขาไวดวยกันภายใตชื่อ Project ของ LED_BLINK โดย

ใหทําการสั่งผนวกไฟลทั้งหมด 3 ไฟลเขาไวใน Project ดังนี้ 

 สั่งผนวกไฟลชื่อ “main.c” ซึ่งเปน Source Code ที่เราไดเขียนและสั่งบันทึกไวแลวใน

ขั้นตอนที่ผานมาโดยเก็บอยูใน …\LED_BLINK\main.c” 

 สั่งผนวกไฟลชื่อ “p33FJ128GP708.h” ซึ่งเปน Header ของภาษาซี ในการอางถึง

รีจิสเตอรตางๆของ MCU เบอร “dsPIC33FJ128GP708” โดยถาติดต้ังโปรแกรม C30 

ตามคา Default  ไฟลดังกลาวจะเก็บอยูใน “…\MPLAB C30\support\h\” 

 สั่งผนวกไฟลชื่อ “p33FJ128GP708.gld” ซึ่งเปน Script File ของ dsPIC33FJ128GP708 

ที่ทาง MPLAB C30 สรางเตรียมไวให โดยถาติดต้ังโปรแกรมตาม C30 ตามคา Default

ไฟลดังกลาวจะเก็บอยูใน “…\MPLAB C30\support\gld\” 
 

***หมายเหตุ*** คา Default มาตรฐานของการติดต้ังโปรแกรมคอมไพลเลอร C30 โดยปรกติแลวโปรแกรม

จะถูกติดต้ังไวที่ “C:\Program Files\Microchip\MPLAB C30“ 
 

โดยในการสั่งผนวกไฟลทั้ง 3 ดังกลาวใหทําการคลิกเมาสไปยัง “ICON” ของไฟลจากตําแหนง 

Folder ที่กลาวไวในขางตนที่ผานมาแลวเลือก “Add >>” จนชื่อไฟลดังกลาวไปปรากฏอยูที่กรอบหนาตาง

ดานขวาของโปรแกรม ซึ่งใหเลือกทําตามวิธีการนี้จนสามารถสั่ง “Add” ไฟลไดครบทั้ง 3 ไฟล แลวเลือก 

“Next >” เพื่อไปยังขั้นตอนตอไปดังรูป 
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 เมื่อสั่งผนวกไฟลทั้งหมดเขากับ Project ไฟลที่สรางขึ้นเปนที่เรียบรอยแลว โปรแกรมจะรายงานผล 

โดยแสดงคาพารามิเตอรตางๆที่ไดกําหนดไวแลวใหทราบดังรูป ใหเลือก “Finish” เปนอันเสร็จขั้นตอนของ

การสราง Project File ของ BLINK_LED  
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 ซึ่งหลังจากกําหนดคาตางๆใหกับ Project File เปนที่เรียบรอยแลว ผูใชก็สามารถทําการสั่งแปล

คําสั่งของโปรแกรม “main.c” ที่เขียนขึ้นไดทันที โดยใชคําสั่ง “Project → Build All” ซึ่งจะทําใหไดไฟล 

Output มีชื่อเดียวกับ Project File ที่สรางไวแตมีนามสกุลเปน HEX ซึ่งจากตัวอยาง Project นี้เมื่อสั่งแปล

โปรแกรมแลวถาไมเกิดขอผิดพลาดใดๆจะได Output ไฟลชื่อ “LED_BLINK.HEX” โดยไฟลดังกลาวจะถูก

สรางและเก็บไวในตําแหนง Folder ของ Project คือ  “…\led_blink\led_blink.hex” โดยผูใชสามารถสั่ง 

Download Hex File ชื่อ “LED_BLINK.HEX” นี้ใหกับบอรด “ET-dsPIC33WEB V1.0” เพื่อทดสอบการ

ทํางานไดทันที  
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การ Download Code ใหกับบอรด 
 หลังจากทําการเขียนโปรแกรมและสั่งคอมไพลจนได HEX เรียบรอยแลว ขั้นตอนการพัฒนา

โปรแกรมของบอรดก็จะเหลือเพียงการ Download Code ใหกับ MCU ซึ่งในขั้นตอนนี้จะตองใชเครื่องมือใน

การ Download Code รวมดวย ซึ่งอาจเปน ICD2 หรือ Pickit2 ก็ได 

 สําหรับในกรณีที่ใช ICD2 นั้นจะสามารถสั่ง Download Code ไดจากโปรแกรม MPLAB โดยตรง

เลย โดยใหทําการเชื่อมตอสายสัญญาณจาก “ICD2” เขากับบอรด “ET-dsPIC33WEB V1.0” แลวเลือก

สวิตช Mode ใหอยูในตําแหนง PGM (สวิตชอยูในตําแหนงถูกกด LED PGM สีแดงติดสวาง) จากนั้นเลือก

กําหนดการเชื่อมตอกับ ICD2 โดยการคลิกเมาสที่เมนูคําสั่ง “Programmer → Select Program → 

MPLAB ICD 2” จากนั้นใหสั่ง Download Code โดยคลิกเมาสที่เมนูคําสั่ง “Programmer → Program” 

ซึ่งเครื่องก็จะทําการ Download Code ใหเองโดยอัตโนมัติ จนเมื่อเสร็จเรียบรอยแลว จะมีขอความแจงให

ทราบคือ “MPLAB ICD2 Ready” ดังรูป 

 

 
 

 ซึ่งหลังจากทําการ Download Code เรียบรอยแลวใหเลือกสวิตช Mode ไปไวในตําแหนง Run โดย

ใหตําแหนงของสวิตช Mode อยูในตําแหนงปลอย และ LED Run สีเขียวติดสวาง จากน้ันใหกดสวิตช 

Reset 1 ครั้ง บอรดก็จะเริ่มตนทํางานตามคําสั่งที่ Download ใหแลวในทันที 
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การ Download Code ดวย “ET-PGMPIC USB” 
สําหรับในกรณีที่ผูใชเลือกใชเครื่องโปรแกรม Pickit2 หรือ ET-PGMPIC USB นั้น ในปจจุบัน 

โปรแกรม MPLAB ยังไมไดสรางการเชื่อมตอคําสั่งกับเครื่องโปรแกรมดังกลาวไวให ดังนั้นผูใชจึงไมสามารถ

สั่ง Download Code ผานทางโปรแกรม MPLAB ไดเหมือน ICD2 แตจะตองสลับไปใหโปรแกรม Pickit2 

เพื่อสั่ง Download Code เองดังนี้ 

1. ตอสายสัญญาณ ICD2 จาก ET-PGMPIC USB เขากับบอรด ET-dsPIC33WEB V1.0 โดยให

เลือกกําหนด Jumper “B/T” ของ ET-PGMPIC USB ไวในตําแหนง “B” (Target Board) พรอมกับ

กําหนดสวิตชเลือก Mode ของบอรด “ET-dsPIC33WEB V1.0” ไวในตําแหนง PGM (LED PGM สี

แดงติดสวาง) 

2. สั่ง Run โปรแกรม Pickit2 ถาทุกอยางถูกตองจะไดผลดังรูป 
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3. ทําการคลิกเมาสที่เมนูคําสั่ง “Device Family → dsPIC33” ซึ่งเครื่องโปรแกรมจะทําการเชื่อมตอ

กับ MCU พรอมกับอานคา Configuration ตางๆของ MCU ขึ้นมาแสดงผลใหเห็นที่หนาจอของ

โปรแกรม ใหเห็นในทันที ซึ่งในกรณีของบอรด “ET-dsPIC33WEB V1.0” นั้น ถาทุกอยางถูกตองที่

หนาจอของโปรแกรมจะแสดงขอความ “dsPIC33 device found” พรอมกับมีการแสดงเบอรของ 

MCU (Device) เปน “dsPIC33FJ128GP708” ดังรูป 
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4. ใหทําการสั่ง Load HEX File ที่ไดจากการแปลโปรแกรมของ C30 โดยใหทําการคลิกเมาสที่เมนู

คําสั่ง “File → Import Hex” แลวเลือก HEX File ที่ไดจากจากแปลคําสั่งของ C30  ซึ่งถาทุกอยาง

ถูกตอง จะปรากฏขอความ “Hex file successfully imported” ซึ่งหมายถึงการสั่ง Load Hex ไฟล

เรียบรอยแลว ซึ่งผูใชสามารถสั่ง Download Code จาก Hex File ใหกับหนวยความจําของ MCU

ไดทันที โดยการคลิกเมาสที่ปุมคําสั่ง “Write” ดังรูป 
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5. เครื่อง “ET-PGMPIC USB” จะเริ่มตนทําการ Download Code ใหกับ MCU ในทันที เมื่อการ 

Download Code เสร็จเรียบรอยแลว จะมีขอความ “Programming Successful” ดังรูป 

 

 
 

6. หลังจากทําการ Download Code เรียบรอยแลว ใหทําการเลือกกําหนดการทํางานของสวิตช 

Mode ของบอรด ET-dsPIC33WEB V1.0 ไปไวในตําแหนง Run โดยใหตําแหนงของสวิตช Mode 

อยูในตําแหนงปลอย และ LED Run สีเขียวติดสวาง จากนั้นใหกดสวิตช Reset 1 ครั้ง บอรดก็จะ

เริ่มตนทํางานตามคําสั่งที่ Download ใหแลวในทันที 
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ตัวอยางการพัฒนาโปรแกรม Web Server Control ของ ET-dsPIC33WEB V1.0
 

 

 

ความตองการทางดานฮารดแวร (Hardware Requirements)   

อุปกรณที่ใช 

- บอรดไมโครคอนโทรลเลอร  ET-dsPIC33WEB V1.0 

- โมดูล ET-MINI ENC28J60 

- สายเชื่อมตอวงจร อยางนอย 13 เสน 

- จอแสดงผล  Character LCD  ขนาด 16 ตัวอักษร 2 บรรทัด 

- โมดูล EEPROM 25LC256 

- เครื่องโปรแกรม PIC/dsPIC รุน ET-PGMPIC USB หรือรุนอ่ืนๆ พรอมสายเชื่อมตอ USB 

- แหลงจายไฟสําหรับบอรด ET-dsPIC33WEB V1.0 (7-12V/850mA) 

- เครื่องคอมพิวเตอร ซึ่งมีพอรตเชื่อมตอ Ethernet LAN 

- สายเคเบิลของระบบแลนด ซึ่งมีอยูสองกรณี คือ  

• กรณีที่ 1 คือ การเชื่อมตอเขากับคอมพิวเตอรโดยตรง สาย LAN จะตองเขาสายแบบ Cross 

 

 

 

 

 

 

 

 
 

• กรณีที่ 2 คือ การเชื่อมตอผาน Hub ของเครื่องคอมพิวเตอร Server จะตองเขาสายแบบ Direct 
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ความตองการทางดานซอรฟแวร (Software Requirements)   

- ติดต้ังโปรแกรม MPLAB IDE v7.61 (เวอรชันลาสุด ณ ปจจุบัน กรกฎาคม 2550)  

- โปรแกรมคอมไพลเลอร C30  เวอรชัน 3.01 Student Edition 

- โปรแกรม  TCPIP Stack 4.02  (เวอรชันลาสุด ณ ปจจุบัน กรกฎาคม 2550) 

- โปรแกรม รับสงขอมูลอนุกรม RS232 เชน Procomm หรือ HyperTerminal ของวินโดว  

- โปรแกรม Internet Explorer  หรือ โปรแกรมที่เปด Webpage ทั่วไป 

 

***  ใหทําการติดต้ังโปรแกรมเหลานี้ใหเรียบรอย 

 

ขั้นตอนการทดลอง 

1. ตอวงจรใหเรียบรอยดังนี้ 
 

 
 

รูปแสดงการเชื่อมตอสัญญาณตางๆ เพ่ือทําการทดลอง 
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รูปแสดงบอรดทดลองหลังจากเชื่อมตอสัญญาณตางๆ 
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สัญญาณการเชื่อมตอ 

 สําหรับตัวอยาง Code Program ที่เปน Web Server Control ที่ทาง อีทีที จัดทําขึ้น เพื่อเปนแนวทาง และ

ตัวอยางการใชงาน เพื่อใหผูใชนําไปทดสอบการทํางาน และแกไขพัฒนาตามความตองการนั้น จะเปนการปรับปรุง

มาจากตัวอยาง Code ของ Microchips โดยทางอีทีที ไดนํา Source Code ของ TCP/IP Stack V4.02 จากทาง 

Microchips มาปรับปรุงแกไขใหสอดคลองกับ I/O ตางๆของบอรด ET-dsPIC33WEB V1.0 ซึ่งไดมีการปรับปรุง

และแกไขดัดแปลง Code เฉพาะในสวนของ Webpage และ HTML สวนของการ Process I/O Function เทานั้น 

สวนรายละเอียดการใชงานฟงกชั่นตางๆที่เปนของ TCP/IP Stack นั้นจะยึดตามตนฉบับของ Microchips เปนหลัก 

ซึ่งผูใชสามารถศึกษารายละเอียดตางๆเกี่ยวกับการใชงาน ฟงกชั่นตางๆของ TCP/IP Stack ไดจากเอกสารที่ทาง 

Microchips จัดทําไวใหไดเอง โดยจะไมขอกลาวถึงในที่นี้ดวย 

โดยในตัวอยางทาง อีทีที จะจัดทําเปนลักษณะของการประยุกตใชงาน Web Server Control ขนาดเล็ก 

โดยแสดงใหเห็นวิธีการรับสงคําสั่งจากหนา Webpage สําหรับควบคุมการทํางานของอุปกรณ I/O ตางๆ ที่อยูใน

บอรด ET-dsPIC33WEB V1.0 ทั้ง Digital Output (LED), Digital Input (SW), Analog Input (ADC) และ LCD 

Display โดยในการทดลองตามตัวอยางโปรแกรม ใหทําการเชื่อมตอสัญญาณ I/O ของ MCU กับวงจร I/O ตางๆ

ตามรายละเอียดดังตอไปนี้ 

• Ethernet Module สําหรับใชในการเชื่อมตอกับ Ethernet LAN จะใชโมดูล ET-MINI ENC28J60 

ซึ่งสามารถรับสงขอมูลไดดวยความเร็วสูงสุด 10MB โดยฟงกชั่นในการเชื่อมตอจะใชสัญญาณ 

SPI1 ของ MCU โดยใชสัญญาณตางๆดังนี้ 

 RF6 ใชเปน SCK ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RF7 ใชเปน SDI ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RF8 ใชเปน SDO ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RD14 ใชเปน CS ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RA12 ใชเปน INT1 ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper INT(EN/DS) เปน DS(Disable:ไมใชงาน) 

 RA13 ใชเปน WOL ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper WOL(EN/DS) เปน DS(Disable:ไมใชงาน) 

 RD15 ใชเปน RST ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper RST(EN/DS) เปน DS(Disable:ไมใชงาน) 

• SPI Memory Module สําหรับใชเก็บ Webpage File และ CGI Scrip ตางๆ จะใชโมดูล 

25LC256 โดยฟงกชั่นการเชื่อมตอจะใชสัญญาณ SPI2 ของ MCU โดยใชสัญญาณตางๆดังนี้ 

 RG6 ใชเปน SCK ในการเชื่อมตอกับ SPI Memory 

 RG7 ใชเปน SDI ในการเชื่อมตอกับ SPI Memory 

 RG8 ใชเปน SDO ในการเชื่อมตอกับ SPI Memory 

 RD12 ใชเปน CS ในการเชื่อมตอกับ SPI Memory 
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• I/O Control Signal สําหรับใชควบคุมการทํางานและรับคา Input มาแสดงผลที่หนา 

Webpage โดยจะมีอยูดวยกัน 4 กลุม คือ 

  8 Bit Digital Output โดยใช LED เปนตัวแสดงสถานะของการทํางาน 

 4 Bit Digital Input โดยใช Push-Button Switch เปน Input 

 1 ชอง Analog Input ขนาด 12 Bit โดยใชตัวตานทานปรับคาไดเปน Input 

 Character Display LCD 16x2 สําหรับแสดงผลขอความตางๆ 
 

 

dsPIC33FJ128GP708 LED 

RB8 LED1 

RB9 LED2 

RB10 LED3 

RB11 LED4 

RB12 LED5 

RB13 LED6 

RB14 LED7 

RB15 LED8 
 

dsPIC33FJ128GP708 SW 

RD8 SW1 

RD9 SW2 

RD10 SW3 

RD11 SW4 
 

dsPIC33FJ128GP708 VR1 (0-3V3) 

RB5 VR1 
 

dsPIC33FJ128GP708 LCD 

RD0 D4 

RD1 D5 

RD2 D6 

RD3 D7 

RD4 RS 

RD5 RW 

RD6 EN 
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การกําหนดคา Configuration ใหบอรด ET-dsPIC33WEB V1.0 

 ตามปรกติแลวคา Configuration ตางๆของบอรด จะถูกกําหนดไวแลวในสวนของ Source Code ไมวาจะ

เปนคา IP Address, DHCP Name หรืออ่ืนๆ ซึ่งคา Configuration ตามคา Default ที่กําหนดไวภายใน Code นั้น

ตามตัวอยางที่ทาง อีทีที จัดทําขึ้นจะเปนดังนี้ 

 Device IP Address คือ 192.168.1.200 

 Gateway IP Address คือ 192.168.1.255 

 Subnet mask คือ 255.255.255.0 

 DNS Server IP Address คือ 192.168.1.255 

 DCHP Protocol = Enable ,DHCP name = dspic33web 
 

แตอยางไรก็ตามผูใชสามารถเขาไปแกไขคา Configuration ตางๆไดเอง โดยไมจําเปนตองกลับไปแกไขที่ 

Source Code ก็ได ซึ่งการแกไขจะกระทําผานพอรตสื่อสารอนุกรม RS232 ชอง 2 (RS232-CH2) โดยใชโปรแกรม

จําพวก Serial Terminal ตางๆ เชน Procomm หรือ Hyper Terminal ก็ได โดยใหสั่งเชื่อมตอดวยเงื่อนไขดังนี้ 
 

Baudrate = 19200BPS, Data Bit = 8 Bit, Parity Bit = None, Stop Bit = 1 Bit, Flow Control = None 
 

ซึ่งหลังจากทําการเปดโปรแกรม Hyper Terminal และกําหนดการเชื่อมตอเรียบรอยแลว พรอมกับตอ

สายสัญญาณจาก RS232-CH2 ของบอรด ET-dsPIC33WEB V1.0 กับ Comport PC เปนที่เรียบรอยแลว ใหทํา

การกดสวิตช SW1 ที่ตอกับ Port-RD8 คางไว พรอมกับกดสวิตช RESET ของบอรดแลวปลอย โดยที่ SW1 ยัง

กดคางอยู โดยโปรแกรมมอนิเตอรจะตรวจสอบวา มีการกด SW1 ในตอนเริ่มตนการทํางานหรือไม ซึ่งถาพบวามี

การกดสวิตชคางไวเปนเวลาอยางนอย 4 วินาที ก็จะเขาสูโหมดการ Setup Configuration ของบอรด แตถาไมพบ

การกดสวิตชใดๆก็จะขามไปทํางานตามปรกติ โดยถามีการกด SW1 คางไวตอนเริ่มตนการทํางาน(หลังรีเซ็ต) จะมี

การสงขอความและเมนูคําสั่งกลับมาทางพอรต RS232-CH2 ซึ่งผูใชสามารถกดคีย เลือกตัวเลข ตามหัวขอตางๆ 

เพื่อทําการเปลี่ยนแปลงแกไขคา Configuration ตางๆไดตามตองการ ดังตัวอยาง 
 

BUTTON0 held for more than 4 seconds.  EEPROM contents erased. 
 
Microchip TCP/IP Config Application (v4.02, Aug 22 2007) 
 
   1: Change serial number:               0 
   2: Change host name:                   DSPIC33WEB 
   3: Change static IP address:           192.168.1.200 
   4: Change static gateway address:      192.168.1.255 
   5: Change static subnet mask:          255.255.255.0 
   6: Change static primary DNS server:   192.168.1.255 
   7: Change static secondary DNS server: 192.168.1.255 
   8: Disable DHCP & IP Gleaning:         DHCP is currently enabled 
   9: Download MPFS image. 
   0: Save & Quit. 
Enter a menu choice: 
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192.168.1.200192.168.1.x 

ขั้นตอนการทดสอบ Web Server Control 

1. ทําการติดต้ัง โมดูล และ เชื่อมตอสัญญาณใหกับอุปกรณ I/O ตางๆดังกลาวขางตนใหเรียบรอย ดังตัวอยาง 

 
รูปแสดงตัวอยางการเชื่อมตอฮารดแวร 

 

2. เชื่อมตอสาย LAN ระหวางบอรด เขากับระบบเครือขาย LAN โดย  กรณีที่เชื่อมตอผาน HUB จะตองใช

สาย แบบ Direct และ กรณีที่เชื่อมตอเขากับการด LAN ของเครื่องคอมพิวเตอรจะตองใชสายแบบ Cross 

ดังรูปตอไปนี้ 

 

 

 

 

 

 

 

 

 

รูปแสดงการเชื่อมตอ ET-dsPIC33WEB เขากับการด LAN ของคอมพิวเตอรใชสายแบบ Cross 
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ET-dsPIC33 WEB V1.0

HUB

Direct Line

Direct Line

Direct Line

192.168.1.200 

192.168.1.x 192.168.1.x 

รูปแสดงตัวอยางการตั้งคา IP Address ของคอมพิวเตอร 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปแสดงการเชื่อมตอ ET-dsPIC33WEB เขากับ HUB ของระบบ LAN ใชสายแบบ Direct 
 

3.  ทําการดาวนโหลด Code ซึ่งอยูใน “\DEMO_WEB_TCPIP_V4\TCPIP Demo App\TCPIP Demo App.HEX” 

ใหกับบอรด โดยสามารถศึกษาขั้นตอนการ Download Code ไดจากหัวขอ “การ Download Code ใหกับบอรด” 

ในสวนของคูมือการใชงาน 

4.    ทําการเซตคา IP Address ของคอมพิวเตอรให Subnet mask: และ IP address ใหเปนคลาสเดียวกันกับ

บอรด ET-dsPIC33WEB V1.0  ในตัวอยางนี้ IP ของบอรด คือ  192.168.1.200 เราจะตองเซต IP ของเครื่อง

คอมพิวเตอรใหเปน  192.168.1.xxx  (xxx = 0  ถึง 255 แตตองไมซ้ํากับ 200 ซึ่งเปน IP ของบอรด)  สวน Subnet 

mask: ต้ังเปน 255.255.255.0  ดังรูปตอไปนี้ 

 

 

 

 

 

→
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5. เปดโปรแกรม Command Prompt ซึ่งจะอยูในโฟลเดอร “…\DEMO_WEB_TCPIP_V4\TCPIP Demo App” 
 

 

 

 

 

 

 

 

 

 

 

 

 

 เมื่อดับเบิลคลิก ICON ดังกลาวจะปรากฏหนาตาง Command Prompt ดังตอไปนี้ 
 

C:\...\ DEMO_WEB_TCPIP_V4\TCPIP Demo App> 

 

6. ลองทดสอบการเชื่อมตอโดยใชวิธีการ Ping ไปที่หมายเลข IP ของบอรดในตัวอยางนี้ คือ 192.168.1.200 โดยให

พิมพคําสั่ง ping 192.168.1.200 แลว Enter ดังรูปตอไปนี้   
 

 C:\...\ DEMO_WEB_TCPIP_V4\TCPIP Demo App>ping 192.168.1.200 
 

โดยผลจากการ Ping หากการเชื่อมตอสมบูรณ ก็จะแสดงขอความ ดังตัวอยาง 
 

C:\...\DEMO_WEB_TCPIP_V4\TCPIP Demo App>ping 192.168.1.200 
 
Pinging 192.168.1.200 with 32 bytes of data: 
 
Reply from 192.168.1.200: bytes=32 time<1ms TTL=100 
Reply from 192.168.1.200: bytes=32 time<1ms TTL=100 
Reply from 192.168.1.200: bytes=32 time<1ms TTL=100 
Reply from 192.168.1.200: bytes=32 time<1ms TTL=100 
 
Ping statistics for 192.168.1.200: 
    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss), 
Approximate round trip times in milli-seconds: 
    Minimum = 0ms, Maximum = 0ms, Average = 0ms 
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การคอมไพล Webpage  

 ในเบ้ืองตนผูใชสามารถทําการแกไขเปลี่ยนแปลงรายละเอียดของหนา Webpage ใหมได โดยเขาไปใน

โฟลเดอร “…\Examples\DEMO_WEB_TCPIP_V4\TCPIP Demo App\Webpages” โดยอาจใชโปรแกรม 

Notepad หรือ Text Editor ใดๆในการแกไขโคดเหลานี้ก็ได  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 โดยไฟลที่เปนหนา Webpage จะชื่อ index.html สวนอีก 10 ไฟลที่เหลือเปน CGI Scrip สําหรับใชรับสง

ขอมูลกันระหวางหนา Webpage และ บอรด ET-dsPIC33WEB V1.0 ซึ่งหลังจากทําการแกไขโคดตางๆตาม

ตองการเปนที่เรียบรอยแลว ผูใชจะตองทําการคอมไพลโคดเหลานี้ใหม ใหเปนไฟลแบบ Binary (.bin) เพื่อที่จะได

สั่ง Download ไฟลดังกลาวไปเก็บไวในหนวยความจํา SPI Memory Module (25LC256) ที่อยูในบอรด ซึ่งทาง 

Microchips เองไดสรางเครื่องมือสําหรับอํานวยความสะดวกในการพัฒนาโปรแกรมสวนนี้เตรียมไวใหเราไดใชงาน

ดวย คือไฟล “MPFS.EXE” โดยไฟลตัวนี้เปนโปรแกรมที่ทํางานแบบ Command Line ใชสําหรับแปลงไฟลตางๆที่

อยูภายใน Folder ใหเปน Binary File โดยขั้นตอนในการคอมไพล Webpage File ใหทําดังนี้ 

 เปดหนาตาง Command Prompt โดยคลิกเมาสที่ Shortcut ของ Command Prompt ที่เตรียมไวใหแลวใน

Folder “…\ET-dSPIC33WEB\Examples\DEMO_WEB_TCPIP_V4\TCPIP Demo App” 

 พิมพคําสั่ง MPFS Input Output 

o Input หมายถึง ชื่อของ Folder ที่ใชเก็บไฟลทั้งหมดที่ตองการแปลงเปน Binary File ซึ่งในกรณีนี้ 

คือ Folder ชื่อ “Webpages”  

o Output หมายถึง ชื่อ ไฟล Output ที่ไดจากการแปลง ซึ่งใหกําหนดนามสกุลเปน bin โดยในที่นี้จะ

กําหนดชื่อของ Output File เปน “dspic33web.bin”   
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C:\...\TCPIP Demo App>mpfs Webpages dspic33web.bin 
Adding 'Webpages\BUILDDATE.CGI'... 
MPFS Size so far 247... 
Adding 'Webpages\BUTTON0.CGI'... 
MPFS Size so far 254... 
Adding 'Webpages\BUTTON1.CGI'... 
MPFS Size so far 261... 
Adding 'Webpages\BUTTON2.CGI'... 
MPFS Size so far 268... 
Adding 'Webpages\BUTTON3.CGI'... 
MPFS Size so far 275... 
Adding 'Webpages\INDEX.HTML'... 
MPFS Size so far 7056... 
Adding 'Webpages\LED0.CGI'... 
MPFS Size so far 7063... 
Adding 'Webpages\LED1.CGI'... 
MPFS Size so far 7070... 
Adding 'Webpages\POT0.CGI'... 
MPFS Size so far 7077... 
Adding 'Webpages\STATUS.CGI'... 
MPFS Size so far 7387... 
Adding 'Webpages\VERSION.CGI'... 
MPFS Size so far 7394... 
 

รูปแสดง ผลการคอมไพล Webpage File 

 

 โดยไฟล “dspic33web.bin” ที่ถูกสรางจะอยูในโฟลเดอรเดียวกันกับ โปรแกรม MPFS ซึ่งในกรณีนี้จะอยูที่ 

“…\ET-dSPIC33WEB\Examples\DEMO_WEB_TCPIP_V4\TCPIP Demo App” ดังตอไปนี้ 
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การดาวนโหลด Webpage File ใหบอรด ET-dsPIC33WEB V1.0 

ในตัวอยางการทดลอง Web Server Control นี้ ไฟลตางๆที่เปนของ Webpage นั้น จะตองนําไปเก็บไวใน

หนวยความจําแบบภายนอก ซึ่งก็คือ EEPROM ที่เปน SPI Memory Module เบอร 25LC256 ซึ่งไดทําการติดต้ังไว

ในบอรดเปนที่เรียบรอยแลว โดยใน Code Program ที่สรางขึ้นตามตัวอยางนี้ จะทําใหเราสามารถใช Protocol 

ยอยของ TCP/IP ในการสงไฟลไปยังบอรดผานทางสายสัญญาณ Ethernet LAN ไดทันที โดยให FTP Protocol 

โดยวิธีการนี้เราสามารถเรียกใช คําสั่ง FTP ใน Command Line เพื่อทําการ Login และสงไฟลไปใหกับบอรดได

โดยตรง โดยมีลําดับขั้นตอนดังนี้ 

 เปดหนาตาง Command Prompt โดยคลิกเมาสที่ Shortcut ของ Command Prompt ที่เตรียมไวใหแลวใน

Folder “…\ET-dSPIC33WEB\Examples\DEMO_WEB_TCPIP_V4\TCPIP Demo App” 

 ใชคําสั่ง FTP เพื่อเชื่อมตอกับ IP Address ของบอรด ET-dsPIC33WEB ซึ่งในที่นี้ ก็คือ 192.168.1.200 

 เมื่อผลการ FTP ไดรับการเชื่อมตอ Connected เปนที่เรียบรอยแลวใหทําการ Login โดยใชชื่อ “ftp” และ

ใชรหัสผาน Password เปน “ett” (จะไมมีการ Echo ตัวอักษรของ Password ใหเห็น) 

 เมื่อสามารถทําการ Login ไดสําเร็จใหใชคําสั่ง PUT ในการสงไฟลชื่อ “dspic33web.bin” โดยพิมพคําสั่ง

เปน put dspic33web.bin แลว Enter  

 เพื่อการสงไฟลเสร็จเรียบรอยแลว ใหทําการพิมพคําสั่ง quit เพื่อออกจากการเชื่อมตอกับ FTP Protocol ซึ่ง

หลังจากนี้ก็สามารถใชงาน Web Server Control ของบอรด ET-dsPIC33WEB V1.0 ไดแลว 

 เปดโปรแกรม Internet Explorer แลว พิมพหมายเลข IP Address ของบอรด ซึ่งในที่นี้ คือ 192.168.1.200 

หรือชื่อ DHCP ของบอรด ซึ่งก็คือ dspic33web ลงในชอง Address แลว Enter เพื่อทดสอบ 
 
\…\Examples\DEMO_WEB_TCPIP_V4\TCPIP Demo App>ftp 192.168.1.200 
Connected to 192.168.1.200. 
220 Ready 
User (192.168.1.200:(none)): ftp 
331 Password required 
Password:ett 
230 Logged in 
ftp> put dspic33web.bin 
200 Ok 
150 Transferring data... 
###################################### 
226 Transfer Complete 
ftp: 7595 bytes sent in 0.00Seconds 7595000.00Kbytes/sec. 
ftp> quit 
221 Bye 

 

รูปแสดง ตัวอยางการใชคําส่ัง FTP เพ่ือ Download ไฟล dspic33web.bin ใหบอรด 
 

 หมายเหตุ รหัส Password ที่ปอนใหกับคําสั่ง จะไมมีการ Echo กลับมาใหเห็นดวย ซึ่งผูใชตองพิมพให

ถูกตองตามลําดับทั้ง 3 หลัก (ett) ไมเชนนั้นจะไมสามารถ Login ได ซึ่งถาพิมพผิด และไมสามารถทําการ Login 

ไดใหใชคําสั่ง quit กลับไปกอนแลวเริ่มตนกระบวนการใหม 
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การทดสอบการทํางานของ Web Server Control 

หลังจากทําการ Download Code ใหกับบอรด และ Download Webpage Files ตางๆใหกับบอรดเปนที่

เรียบรอยแลว ผูใชสามารถทําการทดสอบการทํางานของโปรแกรมตัวอยางของ Web Server Control ไดทันที โดย 

ใหเปดโปรแกรม Internet Explorer แลวพิมพหมายเลข IP ของบอรดลงไปในชอง Address ในตัวอยางนี้คือ 

192.168.1.200 ซึ่งจะปรากฏหนาตาง Webpage ดังแสดงในรูป 

 

 
 

รูปแสดง ลักษณะ Web Server Control ของ ET-dsPIC33WEB V1.0 

 

โดยจากตัวอยางโปรแกรมนี้ ผูใชสามารถทําการทดสอบการสงคําสั่งเพื่อควบคุมการทํางานของ I/O ภายในบอรด 

ET-dsPIC33WEB V1.0 จากหนา Webpage ไดโดยตรง ดังนี้ 

• Toggle LEDs สามารถทําการทดสอบไดโดยคลิกเมาสที่ ปุม LED2 -  LED8 ซึ่งผลการคลิกเมาส

แตละครั้งจะสงผลให LED กลับสถานะเปนตรงกันขาม คือ ดับ และ ติด สลับกันไป 

• Write to LCD:  สามารถพิมพขอความตามตองการแตไมเกนิ 32 อักขระ แลวคลิกเมาสที่ปุม 

“Write” เพื่อสงขอความดังกลาวไปแสดงผลที่หนาจอ LCD บนบอรดได  
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• Status จะแสดงผล อยู 3 สวน คือ 

  Analog[AN5:RB5]:  จะแสดงผลจากการแปลงสัญญาณ Analog to Digital ที่ขา RB5 

ซึ่งตออยูกับ VR 10K บนบอรด เมื่อทําการปรับคาของ VR1 ก็จะทําใหคา Status ของ 

A/D เปลี่ยนแปลงตามคาการปรับ โดยมีคาระหวาง 0..4095 

 Switch[RD8..11]: จะแสดงคาสถานะของการกดสวิตช ของ SW1-SW4 ที่อยูบนบอรด 

โดยเมื่อกดจะไดคาเปน “0” แตเมื่อปลอยจะไดคาเปน “1” 

  LED[RB8..15]:  จะแสดงคาสถานะของพอรต RB8..15 ที่ตอกับ LED บนบอรดไว โดย

คาจะเปลี่ยนแปลงไปตามการคลิกเมาสที่ปุม LED2..LED8 โดยถามีคาเปน “1” จะทําให 

LED ดับ แตถาเปน “0” จะทําให LED ติดสวาง สวน LED1 จะไมสามารถสั่งควบคุมการ

ทํางานจากปุมได เนื่องจาก LED1 จะสงวนไวใชแสดงการทํางานของ TCP/IP โดยจะ

กระพริบติดและดับสลับกันตลอดเวลา 

 

การพัฒนาและปรับปรุง Code Program 
 โดยรวมแลว Code ตางๆทั้งหมดที่อยูใน Project นี้จะเปนสวนของ Protocol TCP/IP มาตรฐานทั้งหมด ที่

ทาง Microchips ไดพัฒนาขึ้น ทําใหเราสามารถนํามาเรียกใชงานฟงกชั่นตางๆที่อยูในไฟลตางๆเหลานั้นไดทันท ี

โดยไมจําเปนตองไปแกไข Code ตางๆที่เปนสวนของ Protocol TCP/IP ใหเสียเวลา ซึ่ง Code ในสวนที่เรา

จําเปนตองแกไขนั้น จะเปนในสวนของ Application Layer ของ TCP/IP Stack เทานั้น ซึ่งใน Project นี้ไฟลตางๆที่

เปนของ Application นั้นจะถูกแยกเก็บไวใน Folder ชื่อ “..\DEMO_WEB_TCPIP_V4\TCPIP Demo App” 

 HardwareProfile.h เปนสวนของการกําหนดรายละเอียดของสัญญาณ I/O ตางๆ ที่จะใชในการเชื่อมตอกับ

อุปกรณภายนอก โดยตองกําหนดใหสอดคลองกับระบบฮารดแวรของบอรด ET-dsPIC33WEB V1.0 อัน

ไดแก Ethernet Driver (ET-MINI ENC28J60) ,SPI Memory Module(25LC256),LCD,LED,SW,ADC 

 TCPIPConfig.h เปนสวนของการกําหนดคา Default ตางๆเกี่ยวกับ TCP/IP Stack อันไดแก DHCP Name, 

IP Address ของบอรด,MAC Address ของบอรด 

 MainDemo.c เปนสวนของ Main Program ซึ่งจะมีการเรียกใช TCP/IP Stack และนําขอมูลตางๆที่ไดการ 

Stack มาประมวลผล และตัดสินใจ อันไดแกการแปลคําสั่งจาก CGI Scrip เพื่อนํารหัสคําสั่งไปสั่งงาน 

LED Output และ LCD Display รวมทั้งการอานคาสถานะของ I/O ตางๆเพื่อสงออกไป Refresh Status 

ของหนา Webpage เปนตน 

 Wabpage File ตางๆ เชน HTML และ CGI Scrip ใน Folder ชื่อ “Webpages” ซึ่งเปนสวนที่ผูใชสามารถทํา

การดัดแปลงแกไขไดเองตามตองการ แตถามีการแกไขคาใน CGI Scrip ใหมีคาตางจากที่กําหนดไวแลว 

ผูใชจําเปนตองเขาไปแกไข Code ที่อยูในไฟล “MainDemo.c” ใหสัมพันธและสอดคลองกันดวย 
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